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Introduction

Purpose
This manual provides instructions for installing the Passport® PX60 Express Ordering Kiosk.

Table of Contents

Required Tools
The following tools are required to install the Passport PX60 Express Ordering Kiosk:

• Flat-blade Screwdriver
• Phillips® Screwdriver
• USB QWERTY Keyboard
• USB Mouse
• USB Thumb Drive - provided by Gilbarco® Veeder-Root® 

Parts List
The following table lists the spare parts required to install the Passport PX60 Express Ordering 
Kiosk:

Topic Page
Introduction 1

Pre/Post Installation Checklist for Express Ordering Kiosk 4

Installing Express Ordering Kiosk 6

Express Ordering Kiosk Internal Components 64

Troubleshooting 66

Item Description Part Number Quantity
1 Double Data Rate (DDR) 3 Dynamic Random Access Memory (DRAM), 

4 GB, 1066/1333 MHz
M09219B002 1

2 PX60 Motherboard with Q67 Chipset M09219B003 1

3 Cable Assembly, Serial RJ-45 to DB9 15” M09747B010 3

4 Hard Drive, 2.5”, Serial Advance Technology Attachment (SATA), 
V32.8.06 REBUILT

KS702A0022D 1

MDE-5183D
Passport® PX60 Express Ordering Kiosk

Installation Guide
January 2024
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Technical Support
If you need to contact Gilbarco Technical Assistance Center (TAC), call 1-800-743-7501. To 
contact Gilbarco Support Center, call 1-877-503-4971.

If you need assistance installing or configuring the kiosk software, contact Xpedient® for 
technical assistance at 1-888-501-8836, or e-mail support@xpedientsoftware.com.

If you need assistance configuring and troubleshooting the Kitchen Monitor system, contact 
MicroPlus Inc. at 1-919-816-9222.

Related Documents

Abbreviations and Acronyms

Document 
Number Title GOLDSM Library
MDE-3620 Point of Sale (POS) Systems Site Preparation Manual Site Prep

MDE-4866 Passport Firewall Router Start-up and Service Manual Passport

MDE-4954 Passport Start-up and Service Manual for the Cisco® Firewall Router (Q13708-08) Passport

MDE-4956 Honeywell® Xenon™ 1900 Scanner Setup/Service Instructions POS Peripheral

MDE-5083 Passport Hardware Start-up and Service Manual for PX60 Platform Passport

MDE-5187 Express Ordering Kiosk Quick Reference Poster Passport

PT-1877 Retail Automation Products Illustrated Parts Manual Parts Manual

Term Description
AIO All-in-One

BIOS Basic Input/Output System

CAT5 Category 5

COM Communications

DDR Double Data Rate

DHCP Dynamic Host Configuration Protocol

DIP Dual Inline Package

DMZ Demilitarized Zone

DRAM Dynamic Random Access Memory

EPAD Electrically Programmable Analog Device

GOLD Gilbarco Online Documentation

HDD Hard Disk Drive

LAN Local Area Network

LED Light Emitting Diode

MWS Manager Workstation

NIC Network Interface Card

OPOS OLE for Retail POS

PLU Price Look Up

POS Point of Sale

QR Quick Response

SATA Serial Advance Technology Attachment
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TAC Technical Assistance Center

TCP/IP Transmission Control Protocol/Internet Protocol

TEA Training Effectiveness Analysis

UPS Uninterruptible Power Supply

USB Universal Serial Bus

VESA Video Electronics Standards Association

VGA Video Graphics Adapter

Term Description
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Pre/Post Installation Checklist for Express Ordering Kiosk

PRE-INSTALLATION CHECKLIST
Check 
if OK Procedure Description

Verify the two LAN Drops/Ethernet® runs are 
completed to the main kiosk location and one to each 
of the others.

Main kiosk will have a dedicated Ethernet cable back to the site router 
(Internet access LAN1) and to the Passport Router via the Demilitarized 
Zone (DMZ) port (LAN2). All other kiosks will have one connection to the 
site router (LAN1). Kitchen Monitor will require a LAN drop as well.

Obtain TCP/IP properties from site IT personnel for 
proper configuration to allow access to the Internet to 
LAN1. 

IP Address _____._____._____._____
Subnet Mask _____._____._____._____

Default Gateway _____._____._____._____
Preferred DNS Server _____._____._____._____
Alternate DNS Server _____._____._____._____

Verify the site router has been configured to allow 
remote connection from Xpedient.

Site IT personnel is responsible for setting up the site router.

Verify the kiosk circuit (isolated/dedicated ground) 
location is correct. Ensure space is available for 
Uninterruptible Power Supply (UPS) near the 
mounting location (electrical outlets).

Kiosk and kitchen hardware will be on a dedicated isolated grounding circuit 
(not to be shared with any other equipment).

Refer to MDE-3620 Point of Sale (POS) Systems Site Preparation Manual.

Verify the site has broadband Internet access. Broadband is required for remote support.

Ensure space is available for the keyboard and 
mouse.

Keyboard and mouse are not required to stay connected to the kiosk. If they 
cannot be secured out of reach of site customers, remove them and have 
the site personnel keep available for future use. 

Ensure Passport is on minimum version. Passport minimum required versions:
8.02V, 8.03L, 8.05K, 8.06G, 9.0D, V10.00
V10.00L patch and later for third-party data interface functionality. 

Ensure the Honeywell Xenon 1900 Scanner 
(Q12651-26) has been installed.

The Honeywell Xenon 1900 scanner is the only 2D scanner that has been 
tested and approved by Gilbarco.
Refer to MDE-4956 Honeywell Xenon 1900 Scanner Setup/Service 
Instructions.

Verify if Kitchen Monitor was ordered. If yes, ensure 
proper cables are provided. 

Site IT personnel to provide IP address for Kitchen Monitor setup.
Refer to MDE-5187 Express Ordering Kiosk Quick Reference Installation 
Poster. 

Ensure the site has back office computer or other 
means to provide a Price Book (Xpedient architect).

This information should have been determined during the site survey.

Confirm the software suite from Xpedient is available 
to install via USB drive provided by Gilbarco 
Veeder-Root or remote download from Xpedient.

If Passport is on V10L (minimum), then back office is not required for
Pricebook. This is required only if kiosk was not previously set up at 
Xpedient or customer lab. Kiosk should be imaged with a PC60 Passport 
Client image from the factory.

Ensure that you have the latest version of Adobe® 
Flash® Installer from the USB drive provided by 
Gilbarco Veeder-Root.

This program is required to load Xpedient software but may have to be 
downloaded to the kiosk at the time of installation. Ensure all windows are 
closed prior to installing.

Obtain all equipment serial numbers and e-mail them 
to Xpedient (support@xpedientsoftware.com) to 
obtain an activation license.    

This is required to be performed prior to installation of the system to ensure 
that the license is available during the day of installation. 

Ensure that the pre-installation checklist is completed before installation 
begins, preferably days before installation.

IMPORTANT INFORMATION
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INSTALLATION CHECKLIST
Check if OK Procedure Description

Expand the DMZ IP Range in the Passport Router 
10.5.60.30-40.

For proper programming, refer to MDE-4954 Passport 
Start-up and Service Manual for the Cisco Firewall Router 
(Q13708-08) and MDE-4866 Passport Firewall Router 
Start-up and Service Manual.

Enable second Network Interface Card (NIC) card. (This only 
applies to main kiosk.)

Kiosk has two NIC cards, one card needs to be manually 
enabled in Basic Input/Output System (BIOS). One Ethernet 
connection is used for Internet access and the other one is 
used for the Passport DMZ.

Connect LAN cables to LAN1 and LAN2. The LAN1 connection is required for Internet access and to 
allow Xpedient to update software and provide remote 
support. LAN2 connects to the Passport Router DMZ Port 
(main kiosk only).

Login as Passport technician and elevate the Passport user to 
admin.

If this process is not completed, you will not be able to install 
the software properly.

Ensure receipt number range is set up properly for each kiosk (if 
necessary). Xpedient will try and make this process automated.

Kiosk 1 is typically set to 1-200.
Kiosk 2 is typically set to 201-400, etc.
All kiosks are defaulted to 1-200.

Ensure all kiosk printers are named LOCAL (all capitalized 
letters).

The Xpedient software is hard-coded to look for printer 
named LOCAL when sending receipt information.

Ensure printer Dual Inline Package (DIP) switch settings are 
completed.

TM-T88V settings (9600, 8, none, 1, DTR/DSR). 
All switches are off except DSW1 #7=on.
To check settings, hold Feed button while powering on, 
receipt will print with DIP switch settings.

POST INSTALLATION CHECKLIST
Check if OK Procedure Description

Create order from each kiosk and verify scan code. This should be performed on each Passport console to 
ensure proper functionality.

Verify kiosk configuration with the store manager. Follow Xpedient’s directions (call Xpedient for any 
questions at 1-888-501-8836).

Scan Quick Response (QR) Code and test Passport 
functionality.

Ensure Passport is processing QR codes properly and 
check that items on the Passport receipt match items on the 
kiosk receipt.

Complete the Training Effectiveness Analysis (TEA) 
interview.

A Gilbarco associate will ask a series of questions on the 
installation, training, and documentation provided. Provide 
an honest feedback.

Show the site personnel how to enter receipt information 
manually if the scanner or QR codes are not working.

Customer will need to manually enter items in Passport 
(process may be customer specific).

Verify the virtual keyboard is functional. -

Verify remote connectivity with Gilbarco and Xpedient. Call Gilbarco TAC at 1-800-743-7501 or Gilbarco Help Desk 
at 1-877-503-4971, and Xpedient at 1-888-501-8836 to 
confirm remote access is functioning.

Ping test all kiosks with each other and with back 
office/corporate computer.

-
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Installing Express Ordering Kiosk
To install the Express Ordering Kiosk, proceed as follows:

1 Ensure that the pre-installation checklist has been completed.
Note: This must be done to complete many of the following steps.

2 Unpack the system components.

3 Set the DIP switch settings on all printers (default setting may not work). 

The following table shows the DIP switch settings for Epson® printers:

Note: Epson printers for Passport are shipped with different DIP switch settings than 
described in the table. Ensure that you configure the DIP switches to match the settings 
in the table.

Connecting the Kiosk 

To connect the kiosk, proceed as follows: 

1 Connect the 9-pin barrel connector of the AC power cable from the power brick located under 
the kiosk pedestal. 

2 Connect the printer power cables. 

3 Connect the two LAN cables via dual NIC card.

a Connect LAN 1 cable labeled “Router” to access the store/corporate network for Internet 
access and Xpedient remote support.

b Connect LAN 2 cable labeled “N/A” configured for DMZ on Passport Router on the main 
kiosk only. 

DIP Switch Description Settings
TM T881V DSW 1 and 2 All Off

OLE for Retail POS 
(OPOS) Settings

19200, 8N1 with Flow Control

TM T88V DSW 1 All Off Except #7

DSW 2 All Off

OPOS Settings 9600, 8N1 DTR/DSR
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4 Connect the printer communication cable. 

To connect the printer communication cable from the kiosk to the printer without the dongle: 
• Red: M11247B050 connected to printer.
• Connect the CAT5 cable to COM port 5 on the kiosk.

After the setup is complete, USB keyboard and mouse (temporarily installed) can be removed 
and retained for reuse.

Figure 1: Connections 

5 Apply power to the unit and enter BIOS setup. (Turn on secondary NIC for KIOSK001.) 

a When the logo shown in Figure 2 is displayed, press Delete on keyboard to enter BIOS.

Figure 2: Logo Display 

b Once prompted, enter the BIOS password PASSASC.

Figure 3: Entering BIOS Password 

Printer Power

LAN2 DMZ Connection to 
Passport Secure Router 
(Main Kiosk ONLY)

LAN1 
Store/Corporate 
Connection

Keyboard and Mouse

Printer Kiosk Power
Connection

Printer Data
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c Select Chipset > South Bridge. 

Figure 4: Navigating to South Bridge

d Select 2nd LAN Controller.

Figure 5:  Navigating to 2nd LAN Controller

e Select Enabled, then press Enter.

Figure 6: Enabling 2nd LAN Controller

f Press F4 on the keyboard. The dialog box shown in Figure 7 opens.

Figure 7: Saving Configuration

 g Select Yes and press Enter.
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6 Once the unit loads and the dialog box shown in Figure 8 opens, rename the computer from the 
Standard Client Image convention.

a Name kiosks based on the standard naming convention (KIOSK001, KIOSK002, 
KIOSK003), and then click OK.
Note: You cannot name the kiosks the same system name or you will have issues with Kitchen 

Monitor printing. 

Figure 8: Naming Kiosks

b When the dialog box shown in Figure 9 opens, select Yes. The unit will reboot.

Figure 9: Confirming Kiosk Name

Note: Prior to selecting Yes, record the requirement in step 7a.

7 Once the system has booted, log in as Passport technician and elevate the Passport user to 
Admin. 

a When the Windows® logo displays, hold the left Shift key until the login screen opens.

b On the Login screen, enter the following credentials:
• Username: passporttech
• Password: 911Tech
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c Select Start > Control Panel > User Accounts.

Figure 10: Selecting User Accounts

d  Select Manage another account.

Figure 11: Selecting Manage Another Account

e Select Passport.

Figure 12: Selecting Passport Account



MDE-5183D Passport® PX60 Express Ordering Kiosk Installation Guide · January 2024 Page 11

Installing Express Ordering Kiosk

Obs
ol

et
e

f Select Change the account type.

Figure 13: Changing Account Type

g Select Administrator > Change Account Type and exit.

Figure 14: Selecting Administrator Login

h Close the User Accounts window, and reboot the system to start as Passport.
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8 Configure LAN1 network adapter settings. 

To configure LAN1 adapter, proceed as follows:

 a Select Start > Control Panel > Network and Sharing Center.

Figure 15: Selecting Network and Sharing Center

b Select Change Adapter Settings. 

Figure 16: Changing Adapter Settings

c  Right-click Local Area Connection on the upper-left and select Properties. 

Figure 17: LAN1 Adapter Properties
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d Select Internet Protocol Version 4 > Properties.

Figure 18: Configuring LAN1 Adapter

e Enter the supplied IP address information and select OK. (This should have been obtained 
from the site IT personnel and recorded on the pre-installation checklist.)

Figure 19: Entering IP Address for LAN1
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9 Configure LAN2 network adapter settings.

To configure LAN2 adapter, proceed as follows:

a Right-click the Local Area Connection 4 on the upper-right and select Properties.

Figure 20: LAN2 Adapter Properties

b Select Internet Protocol Version 4 [TCP/IPv4] > Properties.

Figure 21: Configuring LAN2 Adapter



MDE-5183D Passport® PX60 Express Ordering Kiosk Installation Guide · January 2024 Page 15

Installing Express Ordering Kiosk

Obs
ol

et
e

c Enter the appropriate IP address information from the following table for the kiosk being 
installed and select OK.

Figure 22: Entering IP Address for LAN2

d Close all open windows.

10 Copy files from USB.

a Insert a USB storage device (provided in the installation kit) into an available USB port on 
kiosk to access the required Xpedient software.

b Select the Windows Explorer icon from the task bar.

Figure 23: Starting Windows Explorer

Kiosk Unit IP Address Subnet Mask Default Gateway
Kiosk001 10.5.60.31

255.255.255.0 10.5.60.14

Kiosk002 10.5.60.32

Kiosk003 10.5.60.33

Kiosk004 10.5.60.34

Kiosk005 10.5.60.35
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c Select C:\ > File > New > Folder.

Figure 24: Creating New Folder

d Name this folder Xpedient. 

Figure 25: Naming Folder to Xpedient

e From the left plane, select Removable Disk (D:).

Figure 26: Selecting Removable Disk Drive

f From the toolbar, select Edit > Select all.

Figure 27: Edit Shortcut Menu
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g Select all items on the USB drive as shown in Figure 28.

Figure 28: Selecting USB Drive Files 

h From the toolbar, select Edit > Copy to folder.

Figure 29: Selecting Copy to Folder in Menu 

i Select the C:\ Xpendient folder and click Copy.

Figure 30: Copying to Xpedient Folder 



Page 18                                                                                MDE-5183D Passport® PX60 Express Ordering Kiosk Installation Guide · January 2024 

Installing Express Ordering Kiosk

Obs
ol

et
e

Figure 31 opens indicating the files are being copied.

Figure 31: Copying Files 

Once all the files are copied, remove the USB storage device from the system.

11 Install Adobe Flash.

To install Adobe Flash, proceed as follows:

a Select Start > Windows Explorer > C: > Xpedient > Flash Player 14.

b Double-click flashplayer14_0r0_176_winax.msi.

Figure 32: Executing Adobe Flash Player

c Click Install.

Figure 33: Installing Adobe Flash Player
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d Click Finish.

Figure 34: Completing Installation of Adobe Flash Player

12 Install TeamViewer (remote support software for Gilbarco Support).

To install TeamViewer, proceed as follows:

a Select Start > Windows Explorer > C: > Xpedient > TeamViewer Host.

b Double-click Teamviewer_Host_Setup.exe.

Figure 35: Executing TeamViewer

c Click Next.

Figure 36: TeamViewer Installation Welcome Screen
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d Select Both of the above, and then click Next.

Figure 37: Selecting TeamViewer Environment

e Agree to the terms and click Next.

Figure 38: Accepting License Agreement Terms

f Click Next.

Figure 39: TeamViewer Setup Wizard Screen
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g Enter and confirm password 911Tech and click Next.

Figure 40: Entering TeamViewer Password

h Select I don’t want to create a TeamViewer account now and then click Next.

Figure 41: Selecting TeamViewer Account Option
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i When the screen shown in Figure 42 opens, do not enter any information, only click the 
Finish button.

Figure 42: Completing TeamViewer Wizard

j Once TeamViewer is installed and connected to network, you should see that the unit is 
online and you have a unique TeamViewer ID. Notate the unique TeamViewer ID for 
Gilbarco Help Desk to configure into our system. After notating the TeamViewer ID, click 
OK.

Figure 43: TeamViewer Configuration Confirmation
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13 Install Epson OLE OPOS drivers and test printer functionality. 

To install the OPOS printer, proceed as follows: 

a Select Start > Windows Explorer > C:/ > Xpedient > OPOS. 

b Double-click OPOSN1.12.17.exe.

c Select Unzip, and OK when it is successfully unzipped and close the file.

Figure 44: Extracting OPOS Printer Setup File

d Close the Winzip Self-Extractor window.

e Using Windows Explorer, navigate to C:\OposadkforNET\Ver1.12.17.

f Double-click setup.exe.

Figure 45: Executing OPOS Printer Extracted Setup File

g Choose English as the setup language and click Next.

Figure 46: Choosing Setup Language

(i) (ii)
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h Click Next on the Welcome screen to continue the installation.

Figure 47: Welcome Screen

i On the License Agreement screen, select I accept the terms of the license agreement and 
click Next.

Figure 48: Accepting License Agreement Terms
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j Select User as the type of setup required. Click Next to proceed.

Figure 49: Choosing Setup Type

k Select all the check boxes (Serial, Parallel, USB, and Ethernet) as communication method 
and then click Next to proceed.

Figure 50: Choosing Communication Method for POS Printer - 1

The installer displays the current settings before copying files. 
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l Click Next to proceed.

Figure 51: Copying Files

m Select No, I will restart my computer later when asked to reboot. Click Finish to proceed.

Figure 52: Completing Installation
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Installing Receipt Printer

14 Install the Receipt Printer.

a Click the Start > All Programs menu to confirm that EPSON OPOS for .NET is installed. 

Figure 53: EPSON OPOS for .NET

b Right-click SetupPOS to open the context menu and select Run as administrator. 

Figure 54: Context Menu

c Click  Add.
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d On the Add Device screen, change the Logical Device Name to LOCAL (must be ALL 
CAPS). Select the appropriate printer model from the Device Name drop-down list and click 
Next to proceed. 
Note: In this example, TM-T88V is selected as the Device Name.

Figure 55: Adding Device

e Turn off your receipt printer, press Print Feed, and then turn on the receipt printer power to 
obtain the printout of printer serial specific settings. Cycle power to the printer to return it to 
normal operations once you have validated the settings.

Figure 56: Serial Specific Settings

For proper functionality, the printer serial settings must be set to:
Baud = 9600 
Data Bits = 8 
Parity = None

IMPORTANT INFORMATION
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f Return to the Add Device window and set the Serial Specific settings to match the printer 
receipt. After verifying that the information is correct, click Next.

Figure 57: Verifying Serial Specific Settings

g When the dialog box shown in Figure 58 opens, click Done. 

Figure 58: Confirming Serial Specific Settings

Note: Port name must be configured for COM5.
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h Click Save to permanently update the printer configuration.

Figure 59: POS Printer

i Test the printer to ensure that it is functioning correctly. This can be done using the 
CheckHealth Utility located under Start Menu > All Programs > EPSON OPOS for .NET.

Figure 60: CheckHealth Utility

j Click the + sign beside PosPrinter and click LOCAL to select the specific receipt printer.
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k Click CheckHealth.

Figure 61: Selecting Specific Receipt Printer

l Click Print on the POSPrinter Service window. If your printer is successfully set up, the 
printer generates a small receipt and the POSPrinter Service window opens with a 
“Complete” message.

If the printer was not successfully set up, reprint the configuration from the unit and reattempt 
configuration.

Figure 62: POSPrinter Service

15 Configure Passport for third-party interface. 

Passport Third-party Interface Configuration

Note: For Passport systems running software V10 Service Pack N or later, it is not necessary 
to activate the bundle as it is built into the base package. Proceed to step c on page 33.
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To configure Passport for third-party interface, proceed as follows:

a  Sign onto the Passport Manager Workstation (MWS) with the proper credentials and select 
Feature Activation.

Figure 63: Selecting Feature Activation

b Verify that the Third Party Data Interface bundle is activated.

If the bundle is not activated, call the Gilbarco Help Desk at 1-800-800-7498 for 
activation.

Figure 64: Confirming Third-party Data Interface Activation

If activation is required, it will be necessary to sign off and then back onto the MWS.
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c After validating or activating the Third-party Interface bundle, select Set Up in MWS.

Figure 65: Selecting Setup

d  On the Set Up menu, select Store.

Figure 66: Selecting Store
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e On the Store menu, select Third-party Data Interface.

Figure 67: Selecting Third-party Data Interface

f  In the Price Book section of the interface configuration, it is necessary to check all boxes for 
Export price book when price book is imported from an external source, Export price 
book on a nightly basis, and Copy inbound item List Combo And Match files. After 
selecting these boxes, click Save.

Figure 68: Third-party Interface - Options

g  Press CTRL + ALT + P on the keyboard to access the Passport System Maintenance login.
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h  Provide the current call center credentials for access and click Login.

Figure 69: Call Center Credentials

i When the System Maintenance toolbar opens, select Call Center and then Adv User.

Figure 70: Call Center Credentials - Adv User
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j  When the Advanced User login dialog box opens, enter the appropriate username and 
password.

Figure 71: Logging In - Adv User

k  When the Passport Image Control Panel opens, select Administrative Command Prompt.

Figure 72: Selecting Administrative Command Prompt

Username PassportTech
Password 911Tech
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l  When the command prompt opens, navigate to the C:\Program Files\advantage pos\bin\ 
directory.

m  To access the correct path, type the following and press Enter:

cd \program files\advantage pos\bin

Figure 73: Navigating to Bin Directory of Advantage Pos

n  Once in the appropriate directory, type the following and press Enter:

PricebookExporterJob.exe 

Figure 74: Executing PricebookExporterJob

o Minimize the command prompt.

16 Set up the Passport Secure Router. 
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Passport Secure Router Setup
To set up the Passport Secure Router, proceed as follows:

a  On the Passport Image Control Panel, click Internet Explorer (10.5.48.1).

Figure 75: Passport Image Control Panel

b  When the security dialog box opens, click Continue to this website (not recommended).

Figure 76: Passport Security Dialog
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c  Enter GVR as the username and GVRRV042 as the password when the login screen opens.

Figure 77: Passport Router Login

Note: For locations with the Linksys® Secure Router, enter the following credentials:

d  On the System Summary section, select Setup.

Figure 78: Passport System Summary

e  In the DMZ Setting section, click the Configuration icon.

Figure 79: DMZ Setting

Username admin
Password GVR09RV042



Page 40                                                                                MDE-5183D Passport® PX60 Express Ordering Kiosk Installation Guide · January 2024 

Installing Express Ordering Kiosk

Obs
ol

et
e

f  Program the DMZ IP address to 10.5.60.1 and the Subnet Mask to 255.255.255.0 and click 
Save.

Figure 80: Programming DMZ

g  On the System Summary section, select Firewall and then Access Rules.

Figure 81: Firewall Access Rules

h  At the bottom of the page, click Add.

Figure 82: Adding Firewall Access Rule

i  Create a new access rule with the following parameters:

Action Allow
Service PX52 hardware BOSShare [TCP/139~139 (PX52 hardware)]

PX60 hardware BOSShare [TCP/445~445 (PX60 hardware)]

Log Log packets to match this rule

Source Interface DMZ

Source IP Range 10.5.60.31 To 10.5.60.39

Destination IP 10.5.48.2
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j  Verify that all the settings match the example shown in Figure 83.

Figure 83: Verifying DMZ Settings

k  Click Save.

l  When the dialog box shown in Figure 84 opens, click Cancel.

Figure 84: Confirming DMZ Settings

m  When the Access Rules page is displayed, verify that the new rule is enabled and programmed 
properly.

Figure 85: Verifying New Access Rule
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n  Close the Internet Explorer® page, Passport Image Control Panel and the System Maintenance 
tool bar.

17 Set up third-party router.

Third-party Router Setup
To set up third-party router, proceed as follows:
  

a  Apply power to the Cisco RV042 Router.

b  Press and hold the Reset button on the back of the router for 30 seconds. 

Figure 86: Resetting Router

c  Using a computer with Internet access, connect to the Gilbarco FTP SERVER using the 
following credentials:

d  Navigate to Passport/Peripherals/Router Configs and download the 
Secondary_RV042_Stratup_20131209.config configuration file to your laptop.

Gilbarco FTP ftp://ftp.gilbarco.com/
Username pascget

Password asc4get

The following information is intended for the Passport Cisco Firewall Router. Refer to 
MDE-4954 Passport Start-up and Service Manual for the Cisco Firewall Router 
(Q13708-08), if necessary. 

If the location has a Linksys RV042 Router that is being used for the third-party router, 
refer to MDE-4866 Passport Firewall Router Start-up and Service Manual as necessary.
To perform the same setup for any other router, you must follow the manufacturer’s 
documentation.

IMPORTANT INFORMATION

Reset Button
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e  Disable your laptop’s wireless adapter and connect a CAT5E cable to the network connection 
on your laptop and then to the port 1 of the router.

Figure 87: Connecting CAT5E Cable

f  Open Internet Explorer and navigate to 192.168.1.1.

g  When the security dialog box opens, click Continue to this website (not recommended).

Figure 88: Third-party Router Security Dialog

h  Enter admin as the username and the password when the login screen opens.

Figure 89: Admin Login Screen
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i  On the System Summary menu, select System Management.

Figure 90: System Management

j  On the System Management menu, select Backup and Restore.

Figure 91: Backup and Restore

k  In the Backup and Restore section, click Browse and navigate to the location where you 
previously saved the configuration file on the Gilbarco FTP. Click Restore.

Figure 92: Restore
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l  When the confirmation dialog box opens, click OK.

Figure 93: Confirming Restore

m  When the dialog box shown in Figure 94 opens, enter the password as GVRRV042.

Figure 94: Restore Password

n  During this time, you will lose connection to the router as the configuration is loaded. Close 
Internet Explorer.

o  On your laptop, navigate to Control Panel\Network and Internet\Network Connections.

p  Right-click on Local Area Connection, and select Properties.

Figure 95: LAN Connection Properties
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q  Select Internet Protocol Version 4 (TCP/IPv4), and click Properties.

Figure 96: Protocol Version Properties

r  Select the option Use the following IP address, and click OK after entering the following 
parameters:

Figure 97: Protocol Settings

s  Open Internet Explorer, and navigate to 10.5.60.14.

IP Address 10.5.60.15
Subnet mask 255.255.255.192

Default gateway 10.5.60.14
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t  When the security dialog box opens, click Continue to this website (not recommended).

Figure 98: Protocol Settings Security Dialog

u Enter GVR as the username and GVRRV042 as the password when the login screen opens.

Figure 99: GVR Login Screen

v Once the RV042 System Summary screen is displayed, click DHCP in the left navigation 
column.

Figure 100: Navigating to Dynamic Host Configuration Protocol (DHCP)
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w In the Dynamic IP section, enter the Range Start and the Range End IP addresses necessary 
for all units to communicate.

Figure 101: Dynamic IP Section

x After entering the valid Dynamic Range, scroll to the bottom of the page and click Save.

y Disconnect the CAT5E cable from your laptop and place the Secondary Router sticker 
(supplied in a box) on top of the router.

z    Connect the CAT5E cable you disconnected from your laptop and connect it to the DMZ 
port on the RV042 Secure Passport Router. 

Figure 102: Connecting CAT5E Cable to DMZ Port

Site Setup IP Range Variances 
Equipment Start End
Food Service Only 10.5.60.31 10.5.60.39

Food Service/Back Office 10.5.60.15 10.5.60.39

Food Service/Impulse 10.5.60.31 10.5.60.49

Food Service/Impulse/Back Office 10.5.60.15 10.5.60.49
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aa Connect all Kiosk LAN CAT5E cables and the Back Office LAN CAT5E cable to ports 2, 
3, and 4 of the secondary router.

Figure 103: Passport System with Two Kiosk Units and Back Office

Figure 104: Passport System with Three Kiosk Units and Back Office

For locations running more than two kiosk units, a 10/100 LAN switch will be required 
for proper operations.

IMPORTANT INFORMATION

To Passport 
Secure Router 
DMZ Port

To Back Office Computer To Kiosk Units LAN 2 Connection

To Site LAN/Internet 
Router or Switch

To Passport 
Secure Router 
DMZ Port

To Back Office Computer
To 10/100 LAN Switch

To Kiosk Units LAN 2 Connection
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Mapping Z Drive for Pricebook Synchronization

Note: Mapping the pricebook is ONLY to be performed on the main kiosk (Kiosk001).

18 Map Z Drive for Pricebook Synchronization.

To map Z Drive for Price Synchronization, proceed as follows:

a On Kiosk001, click the Windows shortcut key on the keyboard and select Windows 
Explorer.

b In the Windows Explorer toolbar, click Tools > Map network drive in the drop-down list.

Figure 105: Mapping Network Drive

c Once the Map Network Drive window opens, enter information as follows:

Figure 106: Mapping Kiosk to Network Drive

Drive I:\
Folder \\10.5.60.1\PPXMLDATA\PricebookData

If the system is staged off-site, it is necessary to map the folder to a local one and 
correct this once installed onsite.

IMPORTANT INFORMATION
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Ensure that the Reconnect at logon and Connect using different credentials check boxes are 
selected.

d Click Finish.

e When the credentials window opens, enter the following credentials:

Figure 107: Entering Windows Security Credentials

f Once the username and password credential information have been entered, select the 
Remember my credentials check box, and then click OK.

19 Connect the Kitchen Monitor to customer network.

To connect the Kitchen Monitor to customer network, proceed as follows:

a Connect MicroPlus Kitchen Monitor Electrically Programmable Analog Device (EPAD) to 
customer local network. 

b Connect all peripherals to Kitchen Monitor, including monitor.

c Connect external QWERTY keyboard to MicroPlus EPAD terminal (USB port) and power 
on the unit.

Username PPXMLDATA
Password LØØk4MyD@ta



Page 52                                                                                MDE-5183D Passport® PX60 Express Ordering Kiosk Installation Guide · January 2024 

Installing Express Ordering Kiosk

Obs
ol

et
e

d Enter IP address of MicroPlus EPAD when prompted; confirm IP address is reachable from 
kiosk that is currently on the network (run ping test from Kiosk001).

Figure 108: Mapping Primary Kiosk to Network Drive

20 Install Xpedient software if not already installed. 

To install Xpedient software, proceed as follows:

a Select Start > Windows Explorer > C: > Xpedient.

b Right-click Xpedient2011_Kiosk_7.0.27.zip.

Figure 109: Xpedient Compressed File

Power Cable

Bump Pad

Video Graphics Adapter 
(VGA) Cable

LAN Cable

MicroPlus 
Kitchen 
Monitor
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c Click Extract All.

Figure 110: Extracting Xpedient Compressed File

 d When the screen shown in Figure 111 opens, ensure that the box is checked for Show 
extracted files when complete, and click Extract.

Figure 111: Extracting Xpedient Compressed File
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 e When the new folder opens, double-click KioskInstallationPackage.msi.

Figure 112: Executing Kiosk Installation Package File

f Select Accept to accept the Xpedient License Agreement, and click Next.

Figure 113: Accepting Xpedient License Agreement Terms
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g Leave both the optional settings check boxes cleared, and click Next to proceed (do not 
select Replace OS Shell or Utilize Auto Login).

Figure 114: Xpedient Auto-Login

The Kiosk Settings screen has three tabs that require data entry or review before you can begin 
the installation. 
Note: The second and third tabs are not applicable for kiosks (2 and higher).

Figure 115: Kiosk Settings
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The following is description of the fields in each of the three tabs:

• Order Numbers
The order number range is 1-200 for the main kiosk, 201-400 for the second kiosk, and 
401-600 for the third kiosk. Each kiosk order number range starts at the next number after 
the last and will have 200 order numbers. 

Figure 116: Kiosk - Order Numbers



MDE-5183D Passport® PX60 Express Ordering Kiosk Installation Guide · January 2024 Page 57

Installing Express Ordering Kiosk

Obs
ol

et
e

• Price Sync (NAXML)
This is where you enter the path to the Passport Server to retrieve the price book. The path 
is Z:\\10.5.60.1\PPXMLDATA\Pricebook. If the Z: drive has already been mapped to this 
directory, you only need to enter Z:\ for this field. 

Figure 117: Kiosk - Price Sync (NAXML)
       

• MicroPlus KMS
This is where you enter the IP address for the Kitchen Monitor. The IP is supplied by the 
customer as it is on their store/corporate network. Prior to this step you should have 
already tested the connectivity to the MicroPlus Kitchen Monitor system from the main 
kiosk. If this has not been done at this time enter the IP address as it should be when all is 
connected. If this IP address should change, there is a tool under the Xpedient Installation 
folder MicroPlusIntegrationConfiguration.exe. This tool allows the technician to modify 
the IP address in case incorrect IP address was provided during installation. 

Figure 118: Kiosk - MicroPlus KMS

h Click Next at the bottom of the Kiosk Settings window.
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i Click Install on the Selection Review screen. If successful, the installation displays the “The 
installation has completed successfully” dialog box.

Figure 119: Xpedient Installation - Successful 

If the error shown in Figure 120 opens, you need to correct the mapped drive issue. 

Figure 120: Xpedient Installation - Error

Once the issue is resolved, continue with installation.
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j Click OK and restart the system.

Figure 121: Xpedient Installation - Confirmation

k After the system restarts, select the Kiosk ID and select Set Kiosk ID.

Figure 122: Setting Kiosk ID

l Enter the License Code and select License Kiosk as shown in Figure 123. 
Note: Make note of the Machine Identifier code; provide this information to Xpedient Help 

Desk to get a valid License Code. 

Figure 123: Entering Xpedient License Code
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21 Add remote printer configuration to kiosks 2 and higher.

For all express ordering kiosks numbers 2 or higher, attachment to the Kitchen Monitor via 
TCP is only driven by the primary kiosk. 

All subsequent kiosks must have the remote printer added to their configuration.

To add remote printer configuration to kiosks 2 and higher, proceed as follows:

a On the keyboard, press CTRL + Shift + Alt + F12 simultaneously to minimize the Xpedient 
software.

b Using Windows Explorer, navigate to C:\Program Files\Xpedient\Kiosk\DefaultConfig.

c Right-click KioskConfiuration.xml, select Open with and then click Notepad.

Figure 124: Editing Kiosk Configuration File

d Replace the <RemotePrinterNames /> empty tag with 
<RemotePrinterNames /><string>MICROPLUS</string>RemotePrinterNames.

Figure 125: Replacing Printer Name

e Save the file and restart the kiosk software (only Xpedient kiosk requires a restart, 
everything else can be left running).
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22 Install the Kitchen Monitor system. 
Note: For assistance on configuring and troubleshooting the kitchen monitor system, contact 

MicroPlus Inc. at 1-919-816-9222/1-919-816-9333.

a Connect to corporate network if not already connected. 
Note: Best practice is to have a controller box attached to the screen using Video 

Electronics Standards Association (VESA) mount screws. Retain the screws and 
mounting brackets that are shipped with Kitchen Monitor system. 

An example of a Kitchen Monitor mounted over kitchen preparation area is shown in 
Figure 126. 

Figure 126: Kitchen Monitor Mounted over Kitchen Preparation Area

An example of a Kitchen Monitor placed on the counter in the store area is shown in 
Figure 127. The screen displays a bump bar and bump printer.

Figure 127: Kitchen Monitor on the Counter 
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To change the settings on the Kitchen System for a secondary screen or to add routing 
characters, plug in a keyboard into the MicroPlus system and proceed as follows:

b Press M for menu then press O to change the existing configuration file EDIT 
GILKIOSK.DAT.

c To change value, scroll on the keyboard and press Enter for the required field.

d Press ESC and Yes to WRITE file and then reboot. 

Figure 128: Changing Kitchen System Settings 

23 Work with Xpedient Support team and site management to download site-specific content to 
the kiosk (using ‘GoToMeeting™’ or Xpedient Architect tool).

24 Run a transaction to print QR code, and verify PLUs and kiosk application with default 
configuration.

Figure 129: Kiosk Application Screen

Field Description
Field 43 Used to create a place for a routing character that will be ignored by the first terminal in case you have 

two screens in place driving to kitchen screens with different items.

Field 44 Used on secondary kitchen system to identify characters that are unique for that screen to display only 
particular food items.

Field 45 Used to tell first kitchen system to echo signal out COM1 to secondary kitchen system.

Field 47 Used to tell kitchen system that bump printer is connected and to bump orders to printer port on COM2 
when configured to YES.
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Figure 130: Order Confirmation

Figure 131: Accepting Orders

25 Verify transaction is visible on the Kitchen Monitor. Also, verify that the bump bar and printer 
are functional. If bump bar and printer are not functional, verify system name on all kiosks.

26 Validate the QR code on the Passport system by scanning and verifying all items accounted for 
are on the receipt. If some or all PLUs are missing or scanning fails, refer to 
“Troubleshooting” on page 66. 

27 Verify information on the Passport receipt is accurate and has order number for the correct 
kiosk.

28 Call Xpedient to set up a ‘GoToMeeting’ test session to verify remote access (if not already 
done).

29 Call Gilbarco Help Desk at 1-877-503-4971 to verify remote access.



Page 64                                                                                MDE-5183D Passport® PX60 Express Ordering Kiosk Installation Guide · January 2024 

Express Ordering Kiosk Internal Components

Obs
ol

et
e

Express Ordering Kiosk Internal Components

Hard Drive: SATA Hard Disk Drive (HDD)
SATA HDD (see Figure 132) provides mass storage for the Express Ordering Kiosk.

HDD Tests
To provide more accurate diagnostics, all requests for SATA HDD replacements must be 
accompanied by Drive Fitness Test results. Drive Fitness Test for PX60 allows you to test the 
HDD when it is inside the Express Ordering Kiosk. Refer to “Troubleshooting” on page 66.

Figure 132: SATA HDD

Replacing SATA HDD
To replace the SATA HDD, proceed as follows:

1 Replace the SATA HDD.

a Pull away the cable manager [see Figure 133 (i) on page 65].

b Remove the screw to open the HDD door [see Figure 133 (ii) on page 65].

c Remove the HDD by pulling on the plastic tab of the HDD caddie.

d Remove the HDD from the caddie, and install the replacement HDD.

HDD is very sensitive to shock and vibration. Keep HDD in the original packaging 
materials until installation to avoid damage. Handle HDD carefully to avoid damaging the 
drives. When replacing a HDD, save the packaging material and use it to pack the failed 
HDD, if it is returned.

CAUTION
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e Replace the HDD by sliding the caddie back into the backplane and securing the HDD door 
[see Figure 133 (iii)].

Figure 133: Installing SATA HDD

Replacing the HDD is now complete.

Connecting SATA HDD
The SATA HDD connects directly to the Express Ordering Kiosk HDD backplane through a 
slide-in tray.

Keyboard: USB QWERTY Keyboard
The USB QWERTY keyboard is a standard IBM®-compatible keyboard that connects to the 
Express Ordering Kiosk. This keyboard enables users to input alphanumeric data.

Mouse
A USB mouse connects to the Express Ordering Kiosk and is used to navigate through the 
Express Ordering software.

(i)

(ii) (iii)
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Troubleshooting
The following table describes the symptoms, causes, and possible solutions to troubleshoot 
Express Ordering Kiosk:

Express Ordering Kiosk
Component Symptom Probable Cause Possible Solutions
All-in-One (AIO) Blank screen No Power Check power switch, touch and release power switch.

Look at Light Emitting Diodes (LEDs) visible on kiosk (lower-right corner of 
monitor). Check LED on the power supply (located under the base of the 
pedestal). If the LED is not lit, check the cables.

Check status of the UPS.

Check the AC plug and power from the outlet with a voltmeter.

Bad power supply/cable If the wall outlet has power, but the blue LED on the power supply (brick) is 
off, swap with the known working cable. If no change is seen, swap the 
brick with the known working unit.

Loose or damaged cable Remove and reseat all power cord connections. If the blue LED on the 
power supply (brick) is on, check for damaged pins on low voltage side of 
the cable connecting to the computer power port.

Bad monitor If the blue LED on the bottom-right corner of the monitor is on, remove the 
hardware assembly tray, replace the AIO monitor/module, and reuse the 
original hardware assembly tray with components.

Bad motherboard If the LED at the very bottom-right corner of the monitor is off, but there is 
adequate voltage from the power brick, you may need to replace the 
motherboard using the assembly tray (hard drive should be reused if not 
damaged). 
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Printer Not printing 
receipt

Power Look at the power LED, if it is off, check the power switch, check 
connections, bad AIO motherboard (check for test points). If it is a bad 
printer, swap with a known working printer. If the printer is connected to an 
external power supply, troubleshoot power supply and outlet power.

Connections Check AC (if the printer is connected via external power supply) and DC 
connections from AIO. AC cable for UPS, UPS outlet (120 VAC), AC cable 
to power brick, power brick (swap with a working brick if power is OK and 
LED is off). Verify connections at kiosk printer (Y-cable and gender 
menders depending on the type of Kitchen Monitor system) and printer DIP 
switches. Refer to “Connect the printer communication cable.” on page 7.

Printer configuration For new installation, check the DIP switch settings and that the printer 
configuration name is programmed as “LOCAL” (all caps); wrong serial 
connection, and gender menders.

Printer drivers on kiosk Run OPOS test program, notate error. Confirm that the proper printer 
drivers are installed and are not having issues. If not known, reinstall the 
drivers.

Printer error Ensure that the printer is online with no errors. If errors exist, resolve by 
error type troubleshooting steps (for example, paper, offline, etc.)

DIP switch settings Verify the DIP switch settings for specific model are used (settings will 
vary).

Printer is 
printing 
"?????????"

TM-T88V settings (9600, 8, none, 1, DTR/DSR). All switches are off except 
DSW1 #7=on.

To check the settings, hold the Feed button while powering on, receipt will 
print with DIP switch settings.

Printer not 
printing QR 
code clearly

Wrong paper, worn 
thermal printer head

Verify you are using the correct paper type. If the other kiosk(s) is working, 
use paper from the other printer to test. If the test fails, swap the printer with 
a known working printer.

Printer not 
printing 
complete receipt

Wrong paper, worn 
thermal printer head, 
software glitch

Verify you are using the correct paper type. If the other kiosk(s) is working, 
use paper from the other printer to test. If the test fails, swap printers. If no 
change, reboot the kiosk. If no change, escalate or call TAC.

Order not 
printing to 
kitchen printer

Wrong paper, connections, 
printer configuration, bad 
printer

Check paper, power, verify connections at the kiosk printer (Y-cable and 
gender menders depending on the type of Kitchen Monitor system) and 
printer DIP switches. If other kiosk(s) is working, use paper from other 
printer to test. If the test fails, swap printers. If no change, reboot the kiosk. 
If no change, escalate or call TAC.

Receipts QR code will not 
scan on 
Passport

Poor print quality, wrong 
paper, scanner not 
programed properly, 
wrong scanner (Xenon 
1900), Passport offline 
with MWS Server.

Check print and paper quality, ensure MWS is online, test receipt on 
another Passport POS, ensure Enhanced Store is activated, reprogram the 
Xenon 1900, reboot Passport. If scanner is not working for all scanning 
activities, troubleshoot scanner. For troubleshooting information on the 
scanner, refer to MDE-4956 Honeywell and Xenon 1900 Scanner Setup/
Service Instructions. If the site does not have Enhanced Store, they need to 
purchase it.

If scanning is not working 
customer will need to 
follow manager's standard 
work for manual data 
input.

Ensure customer knows they can input PLUs manually, but will need to be 
advised by their manager on the process.

PLUs on kiosk 
order not 
matching 
Passport PLUs

Price Book not updating 
on Passport or kiosk back 
office connection to kiosk 
or 
Passport bad network 
drive mapping incorrect.

Compare receipts to determine which PLUs are missing; verify missing 
PLUs on Passport. If Passport recognizes PLUs run another transaction 
with the same PLUs. If not, check the QR code quality and follow QR code 
path. 

Network drive mapping incorrect. If on K Patch or above, Price Book will 
reside on Passport (check that kiosk is mapped to Passport).

If kiosk is communicating to back office and Passport has the latest Price 
Book, call Xpedient at 1-888-501-8836.

Express Ordering Kiosk
Component Symptom Probable Cause Possible Solutions
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Communication Cannot ping 
kiosk

IP configuration on kiosk Ensure IP of each unit is set to the correct LAN configuration (kiosk must 
be a static IP to avoid future issues).

Router DHCP settings Ensure DHCP addresses are expanded to accommodate all kiosks.

Windows internal firewalls 
settings

If unit can ping other units but cannot be pinged, ensure that Windows 
firewall settings are correct by temporarily turning off the firewall.

After reboot, 
kiosk requesting 
new license for 
Xpedient 
software

No network connection Ensure unit is connected to LAN and verify Internet functionality.

Remote 
Connectivity

Gilbarco cannot 
connect

Kiosk has wrong IP 
address.
Passport Router 
configuration changed.
LAN cable disconnected 
or connected to wrong 
LAN port on kiosk.
No communication to 
router.
Passport Server 
disconnected.
NetOp not running on 
kiosk.
LAN2 BIOS settings.

Check LAN connections and verify if correct ports are being used. Ensure 
that the kiosk(s) is connected to Passport Router and additional IPs were 
added to router configuration. If Passport Server is offline, the clients will 
also be offline. Verify NetOps is functioning on the kiosk(s).

Xpeditent 
cannot connect

Kiosk has wrong IP 
address.
Site router configuration 
changed.
LAN cable disconnected 
or connected to wrong 
LAN port on kiosk.
No communication to 
router.
‘GoToMeeting’ software 
has not been setup.

Ensure that LAN2 is enabled in BIOS. Check LAN connections and verify if 
correct ports are being used. Check router configuration (will require site IT 
assistance). Ensure that LAN is plugged into the correct LAN port on the 
kiosk. Xpedient to provide a ‘GoToMeeting’ link that will install the proper 
software.

Intermittent 
Hardware Issue

Unit reboots or 
locks up
Printer errors

Hard drive and 
motherboard performance 
issue (running slow, 
lock-ups).
Printer hardware.
Hardware drivers.

Event Viewer.
OPOS for printer issues.
Check drive space.
Run CHKDSK.
Reload driver.

Intermittent 
Software Issue

Windows related 
issues

Document all errors and 
status of kiosk.

Could be a hardware issue; follow intermittent hardware issue steps. 
Contact TAC as necessary.

Xpedient 
software

Document all errors and 
status of kiosk.

Escalate to Xpedient.

Startup Miscellaneous 
problems during 
installation

Not following installation 
checklist.

Always follow the installation checklist. If checklist was followed properly, 
contact Gilbarco and report any problems that were not addressed on the 
checklist.

Express Ordering Kiosk
Component Symptom Probable Cause Possible Solutions
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Kitchen Monitor Not displaying 
kiosk 
transactions 
(serial 
connections)

Connections on kiosk 
printer 
Y-cable and gender 
menders (MicroPlus serial 
setup), monitor 
configuration 
(programming). 

If the site has more than one kiosk, verify if the symptoms are for one or all. 
Screen black, check connections and power. Display has power but is not 
displaying orders, check connections at KMS interface (MicroPlus 
solution), verify whether the gender mender A is used with B for each kiosk 
and power to interface, reset interface and monitor. If connections and 
configurations are fine, it may have bad cable or gender mender. If some 
kiosk transactions are displayed, but not all, check connections for each 
individual kiosk at the monitor interface and at kiosk printer. Reset monitor 
interface and reboot kiosk.

Not displaying 
kiosk 
transactions 
(network IP 
config) This is 
the preferred 
method for the 
Kitchen Monitor 
setup

Check IP Settings on 
MicroPlus Screen. Either 
No IP Configured on 
MicroPlus or IP Address 
never entered into 
Express Ordering software

Confirm MicroPlus EPAD is connected to customer network. Run Ping test 
to confirm you can ping component from Kiosk 001. If no IP address 
configured on MicroPlus, refer to “MicroPlus KMS” on page 57. If the 
connections are correct, you need to make sure that MicroPlus is 
connected with Express Ordering. During Express Ordering installation, 
there is a tab related to the IP addressing of the MicroPlus KMS system. If 
this was ignored, you will need assistance from Gilbarco/Xpedient Help 
Desk to get this configured. If Kitchen Monitor is working with primary Kiosk 
(001) but not secondary kiosks, you need to edit file to add remote printer 
to secondary kiosks. This was detailed above in Kitchen Monitor setup. You 
will need to edit the %localappdata%\xpedient\kiosk\kioskconfiguration.xml 
to address the issue. 

Kiosk 
functionality 
(software)

Wrong prices for 
some items

Price Book not updated Ensure kiosk is communicating to the store network if they have back office 
or to Passport network if using V10 L Patch, escalate to Xpedient.

Wrong content Escalate to Xpedient.

Express Ordering Kiosk
Component Symptom Probable Cause Possible Solutions



© 2024 Gilbarco Inc. 
7300 West Friendly Avenue · Post Office Box 22087
Greensboro, North Carolina 27410 
Phone (336) 547-5000 · http://www.gilbarco.com · Printed in the U.S.A.
MDE-5183D Passport® PX60 Express Ordering Kiosk Installation Guide · January 2024

Gilbarco® and Passport® are registered trademarks of Gilbarco Inc. GOLDSM is a service mark of Gilbarco Inc.

All product names, logos, and brands are the property of their respective owners and are for identification purposes only. Use of these
names, logos, and brands does not imply endorsement.

Obs
ol

et
e

http://www.gilbarco.com
http://www.gilbarco.com

	MDE-5183D Passport® PX60 Express Ordering Kiosk Installation Guide
	Introduction
	Purpose
	Table of Contents
	Required Tools
	Parts List
	Technical Support
	Related Documents
	Abbreviations and Acronyms

	Pre/Post Installation Checklist for Express Ordering Kiosk
	Installing Express Ordering Kiosk
	Connecting the Kiosk

	Express Ordering Kiosk Internal Components
	Hard Drive: SATA Hard Disk Drive (HDD)
	Keyboard: USB QWERTY Keyboard
	Mouse

	Troubleshooting


